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W Introduction

Introduction

These release notes describe requirements, restrictions, and caveats for Cisco Unified Video Advantage.
These release notes are updated for every maintenance release and every major release but not for
patches or hot fixes.

Before you install Cisco Unified Video Advantage, we recommend that you review this document for
issues that might affect your system. For a list of the open caveats, see Open Caveats, page 12.

System Requirements

e Network Requirements, page 2

e (Client Requirements, page 3

e Supported Video Codecs, page 7
e Software Interoperability, page 7
e Compatibility Matrix, page 7

Network Requirements

For Cisco Unified Video Advantage to successfully operate as a video endpoint, your network must meet
these requirements:

e Voice over IP is configured on your Cisco routers and gateways.

e [P network supports DHCP or manual assignment of IP address, gateway, and subnet mask in
Cisco Unified Communications Manager.

e [P telephony networks with access control lists and/or firewalls between voice VLANs and data
VLANSs must be configured so that the access control lists and/or firewalls allow the Cisco Audio
Session Tunnel (CAST) protocol to communicate with the Cisco Unified IP Phone and the PC
(Cisco Unified Video Advantage) over TCP/IP using TCP port 4224. Bidirectional communication
on TCP port 4224 is required.

For details, see the Cisco IP Video Telephony Solution Reference Network Design (SRND) for
Cisco Unified Communications Manager:

http://wwwin.cisco.com/voice/technical/design.shtml

e Cisco Unified Video Advantage uses port 5445 by default. If your firewall blocks this port, users
will receive no video. You will need to configure your firewall to allow access to port 5445 (or
change the UDP port setting during deployment and installation) and enable video.

e (Cisco Unified Video Advantage requires Cisco Unified Communications Manager to handle video
call processing on the Cisco Unified IP Phones:

For Cisco Unified Video Advantage operating with Cisco IP Communicator or with a
Cisco Unified IP Phone, Cisco Unified Communications Manager Version 4.1(3),
Service Release 2 or higher is required.

For other supported Cisco Unified Communications Manager releases, see Compatibility Matrix,
page 7.

e Quality of service is properly configured on your network to provide prioritized treatment of the
audio and video streams.
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For details, see
http://www.cisco.com/en/US/products/sw/voicesw/ps556/products_implementation_design_guides

_list.html

e (Cisco IP Communicator (Release 2.0 or later) or video-enabled Cisco Unified IP Phone are
installed and configured on your IP network with phone loads that support video. The client PC must
be connected directly to the Cisco Unified IP Phone.

e Using Cisco Unified Video Advantage with Cisco IP Communicator for video calls over a corporate
wireless LAN might result in poor audio and video quality and is not supported. Video calls can be
placed or received on a remote wireless LAN connection with a minimum broadband link of
300kbps/300kbps. For best results, we recommend that you use Cisco Unified Video Advantage
over a wired Ethernet connection whenever possible.

Client Requirements

Cisco Unified Video Advantage has these requirements:
e Personal computer (PC)—See PC Requirements, page 3.
e Any video-enabled Cisco Unified IP Phone—See Supported Cisco Unified IP Phones, page 5.
¢ Video camera—See Supported USB Cameras, page 6.

PC Requirements

The PC on which the Cisco Unified Video Advantage software is installed must meet the specifications
listed in Table 1.

S
Note  Cisco Unified Video Advantage is not supported in VM Ware, Citrix, Terminal Services, Remote
Desktop or other thin client environments.
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Table 1 PC Requirements for Cisco Unified Video Advantage

PC Feature

Requirement

Software

Microsoft Windows Vista Business Edition or Enterprise Edition with or without
Service Pack 1

Windows XP Professional with Service Packs 1, 2 and 3
Windows 2000 Professional with Service Pack 4
Microsoft DirectX 9.0c (For details, see the Internal Hardware rows in this table.)
USB audio device hotfixes':
— For Widows XP: KB 914642
— For Windows XP: KB 884868
— For Windows 2000: KB 832339

Internal Hardware

Microsoft Windows Vista

Microsoft Vista Premium Ready PC. For details about the minimum hardware requirements for
Windows Vista (in addition to the requirements in this table), search for Premium Ready PC
on the Microsoft website or see this URL: http://support.microsoft.com/kb/919183

— Only 32-bit (x86) processors are supported with 32-bit versions of Windows Vista.

— Hardware in computers running Vista and Cisco Unified Video Advantage using video
must have a base score of 3 or higher. Run the performance tool by choosing Start >
Control Panel, and clicking Performance and Rating. >

The subscores for Memory (RAM), Graphics, and Gaming Graphics must be 3 or higher.
The Overall Base Score must be 3 or higher.

Free disk space: 200 MB (includes 20 MB free disk space for the Windows camera drivers)

Memory: 512 MB RAM (1 GB RAM or more recommended)

Free physical memory: 48 MB

Dedicated video memory: 256 MB

Video card driver: install the latest version for your OS

A non-ISA full-duplex sound card (integrated or PCI-based) or USB sound device

A 10/100/1000BASE-T Ethernet cable connected to your Cisco Unified IP Phone PC port

At least 1 free USB port (version 2.0)
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PC Requirements for Cisco Unified Video Advantage (continued)

PC Feature

Requirement

Internal Hardware

Microsoft Windows XP

and Windows 2000

CPU speed and type:

— Desktops: 2.4 GHz Pentium IV or higher compatible processor (Streaming SIMD
Extensions support required); 2.8 GHz Pentium IV or higher recommended

— Laptops: 1.5 GHz Pentium M or higher compatible processor (Streaming SIMD
Extensions support required); 1.7 GHz Pentium M or higher recommended

Memory: 512 MB RAM (1 GB RAM or more recommended)
Free disk space: 200 MB (includes 20 MB free disk space for the Windows camera drivers)
Video display:

— Minimum: DirectX 9.0c (or higher) compatible graphics card with 32MB of video RAM.
For dual-headed configurations, 64MB.

- Recommended: DirectX 9.0c (or higher) compatible graphics card with 64MB of video
RAM. For dual-headed configurations, 128MB.

Video card driver: install the latest version for your OS

A non-ISA full-duplex sound card (integrated or PCI-based) or USB sound device

A 10/100/1000BASE-T Ethernet cable connected to your Cisco Unified IP Phone PC port
Atleast 1 free USB port, version 1.1 minimum or 2.0 (Windows 2000 supports full-speed only)

Cisco Unified IP Phone

See Supported Cisco Unified IP Phones, page 5

USB camera

See Supported USB Cameras, page 6.

1. To obtain the hotfixes, go to the Microsoft Support URL: http://support.microsoft.com/contactus/?ws=support or call Microsoft (1-800-MICROSOFT

(1-800-642-7676).

2. If users experience memory leaks while using video and the amount of memory dedicated to video is zero or very small, disable Vista visual effects by
going to Control Panel > Classic View > Performance Information and Tools > Adjust visual effects > Adjust for best performance.

Supported Cisco Unified IP Phones

Note

Cisco Unified Video Advantage is supported on Cisco IP Communicator and on all video-enabled
Cisco Unified IP Phones running the SCCP protocol. Cisco Unified Video Advantage is not supported
on Cisco Unified IP Phones running the SIP protocol. The phone must be CDP and CAST capable.

Cisco Unified Video Advantage does not work with the Cisco Unified IP Phones 7941G, 7961G and
7971G in an SRST environment. (CSCs149074)

These phones are supported for use with Cisco Unified Video Advantage:
Cisco Unified IP Phone 7911G

Cisco Unified IP Phone 7940G

Cisco Unified IP Phone 7941G-GE

Cisco Unified IP Phone 7945G

Cisco Unified IP Phone 7960G

Cisco Unified IP Phone 7961G-GE

Cisco Unified IP Phone 7965G
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Note

e Cisco Unified IP Phone 7970G
e (Cisco Unified IP Phone 7971 G-GE
e (Cisco Unified IP Phone 7975G

Use phone firmware 8.3(2) and earlier to avoid a delay in associating with Cisco Unified
Communications Manager. (CSCsk47200)

For a list of supported Cisco Unified Communications Manager releases needed with these phones, see
the Compatibility Matrix, page 7.

In the phone you are using does not appear in the supported list, see the release notes for the phone:
http://www.cisco.com/en/US/products/hw/phones/ps379/prod_release_notes_list.html

New or existing phones might add support for Cisco Unified Video Advantage after this release of
Cisco Unified Video Advantage.

Supported USB Cameras

Note

Note

Cisco Unified Video Advantage supports these USB cameras:
e Cisco VT Camera II
e Cisco VT Camera
e Logitech QuickCam Fusion
e Logitech QuickCam for Notebooks Pro
e Logitech QuickCam Pro 5000
e Logitech QuickCam Ultra Vision
e Microsoft LifeCam VX-6000
e Microsoft LifeCam NX-6000 Webcam
e Creative Webcam Live Pro USB 2.0 Webcam (see Important Notes, page 10)

Not all cameras are available for all supported operating systems. See your camera documentation for
the supported operating systems.

The camera must be installed and connected to the PC on which the Cisco Unified Video Advantage
software is installed. For details about setting up the third-party camera, see the documentation that
shipped with the camera. For details about setting up the Cisco VT Camera, see the quick start guide:

http://www.cisco.com/en/US/products/sw/voicesw/ps5662/prod_installation_guides_list.html

In this document, references to the Cisco VT Camera include both the Cisco VT Camera and the
Cisco VT Camera II. The Cisco VT Camera II meets all European Union RoHS compliance
requirements.
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Cisco Unified Video Advantage also provides limited support for other third-party cameras. Limited
support includes only camera recognition issues, where the camera is not properly recognized by the
Cisco Unified Video Advantage application. For all other issues involving the third-party cameras, Cisco
will provide best-effort support. Cisco Unified Video Advantage recognizes other third-party cameras
connected to the PC. However, Cisco does not officially support any camera other than those specifically
mentioned above and cannot guarantee their performance and behavior (although best effort will be
made by Cisco to resolve issues on other third-party cameras).

Supported Video Codecs

Cisco Unified Video Advantage supports these video codecs:
e H.263
e H.264

For H.264 codec support, Cisco Unified Communications Manager Release 4.1(3) or higher is
required.

By default, Cisco Unified Video Advantage is configured to support both H.263 and H.264 video codecs.
If both codecs are available, the application gives priority to H.264. For details about customizing video
codecs, see the installation and troubleshooting guide:

http://www.cisco.com/en/US/products/sw/voicesw/ps5662/prod_installation_guides_list.html

Software Interoperability

Cisco Unified Video Advantage, Cisco IP Communicator, and Cisco Unified Personal Communicator
can co-exist on the same client computer. However, we recommend that you do not simultaneously run
Cisco Unified Personal Communicator and Cisco IP Communicator with Cisco Unified

Video Advantage.

Compatibility Matrix

Cisco Unified Video Advantage is compatible with these products:
e Cisco Unified Communications Manager, Releases 4.x, 5.0, 5.1, 6.0, 6.1 and 6.1.2

For H.264 codec support, Cisco Unified Communications Manager Release 4.1(3) or higher is
required.

Cisco Unified Communications Manager Release 4.x does not support video over a SIP trunk. The
Media Termination Point Required option in Cisco Unified Communications Manager
Administration is checked by default and cannot be unchecked.

e Cisco Unified Communications Manager Express, Releases 4.0 [IOS Release 12.4(4.XC4)] and 4.1
[IOS 12.4(15)T]

e Cisco Unified Videoconferencing, Releases 4.2 and 5.1
e Cisco Unified MeetingPlace Express, Releases 2.0 and 2.1
e Cisco Unified MeetingPlace, Releases 5.4 and 6.0

e If you are using Cisco VPN client software, you must use at least Release 4.8. For optimal results,
use version 5.0.01.0600. Make sure to uncheck (disable) the Stateful Firewall setting.
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Note  Cisco no longer supports Cisco VPN client software version 4.0.8.

Related Documentation

For complete documentation for Cisco Unified Video Advantage, see the documentation guide:
http://www.cisco.com/en/US/docs/video/cuva/roadmap/cuva_map.html

You can find related product information at these URLs:

Cisco IP Communicator documentation
http://www.cisco.com/en/US/products/sw/voicesw/ps5475/tsd_products_support_series_home.html
Cisco Unified IP Phone documentation
http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html
Cisco Unified Communications Manager documentation:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

New and Changed Information

e Release 2.1(2), page 8
e Release 2.1(1), page 8

Release 2.1(2)

Cisco Unified Video Advantage Release 2.1(2) has no new features. See Resolved Caveats, page 12 for
the list of defects fixed in this release.

Release 2.1(1)

Cisco Unified Video Advantage Release 2.1(1) provides these new features:
e (Camera support:

— Separate installers for Cisco Unified Video Advantage and for Cisco VT Camera drivers
(Cisco Unified Video Advantage no longer installs the Cisco VT Camera drivers).

~

Note  Upgrading to Cisco Unified Video Advantage Release 2.1(1) removes the Cisco VT Camera
driver. Users must run the installation package for the Cisco VT Camera for upgrades.

e Operating systems: Support for Windows Vista (in addition to the Windows XP and 2000).

¢ Phone support: Cisco Unified Video Advantage supports all Cisco Unified IP Phones running SCCP
(CDP enabled and CAST enabled) that can be enabled for video on Cisco Unified
Communications Manager. For details, see Supported Cisco Unified IP Phones, page 5.
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e Cisco Unified Communications Manager: increased compatibility (see the Compatibility Matrix,
page 7).

e User interface improvements:

Video confirmation (Settings > Video Confirmation): if enabled, Cisco Unified
Video Advantage prompts the user for confirmation before sending video. Regardless of the
user preference, video is not sent if the screen saver is active or if the PC is locked.

The local video window displays information to tell the user to click the camera button to start
the video stream (along with a balloon tip in the system tray).

The setting is saved and applied to the next Cisco Unified Video Advantage session.
Problem Reporting Tool is accessible from Help > Create Problem Report.
Video > Camera On menu option will be disabled if no camera is present.

New options for associating the video with a device (Video > Preferred Device): checking an
option means that Cisco Unified Video Advantage sends video to Cisco IP Communicator or to
the Cisco Unified IP Phone.

¢ Installation and upgrades/updates:

System administrators can specify where log files are stored.

System administrators can use a silent install option when deploying the application to remote
users.

e Serviceability: support for call quality logging enhancements. Includes packet statistics at the end
of each call, total number of packets (sent or received), packets lost or discarded, average and
maximum jitter, and average and maximum delay.

Installation Notes

e Software Download Site, page 9

Software Download Site

Download Cisco Unified Video Advantage software from the Software Center:

http://tools.cisco.com/support/downloads/go/Redirect.x 7mdfid=278875240

You must register for an account on Cisco.com to access the software download site.

On the download site, the installer packages are offered as a single Zip file, which contain all the files
required to deploy the application and the Cisco VT Camera drivers.

The software download site does not contain device drivers for third-party video cameras. These drivers
should be provided by the manufacturer.

For step-by-step installation instructions, see the Installation and Troubleshooting Guide for
Cisco Unified Video Advantage.
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Limitations and Restrictions

You should review Table 2 before you begin working with Cisco Unified Video Advantage. These are
known limitations that will not be fixed, and there is not always a workaround. Some features might not
work as documented, and some features could be affected by recent changes to the product.

Table 2 Closed Caveats for Cisco Unified Video Advantage

Identifier Severity Component Headline

CSCsf21383 2 win32app CUVA hangs and then proceeds to use all available memory
(Memory Leak) on Dell workstations.

CSCsj22071 2 win32app CUVA 2.0 MTU size causes frame errors on sccp-h323-sccp call
setup.

CSCs086553 2 win32app CUVA blue screens if checkpoint VPN is running and connected

CSCeg06701 3 win32app DeployMan for CVTA needs to put installers in CVTA directory.

CSCsel13490 3 win32app Video image using VT Camera I with CUVA 2.0 is blocky.

CSCsel8309 3 win32app Impact on video during call when run with other CPU-intensive
software.

CSCse35005 3 win32app Video Window Pop-Up Response Time.

CSCse35409 3 win32app Shouldn't allow CUVA to launch when CUVA is launched by
another user.

CSCse36933 3 win32app Unable to do H.264 Video with Cisco 7941/61/7x IP Phone on
CCM 4.1(3)sr2.

CSCsh60057 3 win32app 3rd party SIP video phone freeze when calling CUVA with 7970
SCCP phone.

CSCsi03781 3 win32app BSOD on HP Compaq nx6110

CSCsi40055 3 win32app Local video does not display.

CSCsk47200 3 win32app Takes about 30 seconds to associate with some phones.

CSCsk76317 3 win32app High CUVA CPU Usage on minimum requirements AMD desktop.

CSCsk87144 3 win32app Upgrade: XP-Vista: No CDPdrv process running if user starts
CUVA.

CSCsk88647 3 win32app Balloon tooltip for loss of connection is inconsistent.

CSCsl85497 3 win32app No Video Because USB Controller Bandwidth Exceeded.

CSCsl85978 3 win32app User sees Assertion Failed when 2.0.3 install on top of 2.1.0.

CSCsm81353 3 win32app Video discoloration on native resolution in certain systems

CSCs092195 3 win32app VT Camera II is not recognized by CUVA on cold start of machine

CSCsz10052 3 win32app CUVA with VPN client 5.0.4 and McAfee HIPS can cause BSOD

Important Notes

¢ Creative Webcam Live Pro USB 2.0 Webcam light is always lit
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When this camera is connected to the computer, it always has its light lit whether or not it is
capturing video. This means that the camera light state cannot be used to tell if the camera is active
or not during a call. (CSCsk34037)

e Cisco Unified Video Advantage does not work with the Cisco Unified IP Phone7941G, 7961G, or
7971G in an SRST environment. (CSCs149074)

¢ Cisco Unified Video Advantage does not support an upgrade path from Microsoft Windows XP to
Microsoft Vista. Cisco Unified Video Advantage must be uninstalled before an upgrade and
re-installed with the new operating system. (CSCsk87144)

e Using the Bug Toolkit, page 11
* Open Caveats, page 12
e Resolved Caveats, page 12

Using the Bug Toolkit

Step 1

Step 2
Step 3

Step 4

You can search for problems by using the Cisco Software Bug Toolkit. Known problems (bugs) are
graded according to severity level. These release notes contain descriptions of these types of bugs:

e All severity level 1 or 2 bugs
¢ Significant severity level 3 bugs

e All customer-found bugs

Before You Begin
To access Bug Toolkit, you need these items:

e Internet connection
e  Web browser

e Cisco.com user ID and password

Procedure

Go to http://tools.cisco.com/Support/BugToolKit/action.do?hdnAction=searchBugs to access the Bug
Toolkit.

Log in with your Cisco.com user ID and password.

Enter the bug ID number in the Search for Bug ID field, to look for information about a specific
problem.

Click Go.

For information about how to search for bugs, create saved searches, create bug groups, and so forth,
click Help on the Bug Toolkit page.
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Open Caveats

Table 3 describes possible unexpected behaviors by Cisco Unified Video Advantage. Only severity 1,
severity 2, and select severity 3 open caveats, as well as all customer-found defects, are provided in this
document (highest severity listed first and then in alphanumeric order by identifier).

Unless otherwise noted, these caveats apply to all Cisco Unified Video Advantage releases. For details
about an individual defect, click the identifier to access the online record for that defect in the Bug
Toolkit.

Because defect status continually changes, be aware that the tables reflects a snapshot of the defects that
were open at the time this report was compiled. For an updated view of open defects, access the Bug
Toolkit. For details, see the Using the Bug Toolkit, page 11.

Table 3 Open Caveats for Cisco Unified Video Advantage

Identifier Severity Component Headline

CSCsk79193 3 win32app CCME: Unable to re-established video after restarting CUVA
application.

CSCsk88892 3 win32app Problems in CUVA when bandwidth limited.

CSCsk98716 3 win32app After a CM restart, CUVA has to be restarted to have video in the
call.

CSCsl08616 3 win32app If 2 ethernet NIC enabled & active- CUVA cannot associate with IP
Phone.

CSCsl124602 3 win32app Vista: DSCP value for Video call set to 0x000000.

CSCs128608 3 win32app VPN over ethernet-User looses VPN connection CUVA becomes
unresponsive.

CSCsl132819 3 win32app W2K-Black Video check window with CIPC opened.

CSCsl138026 3 win32app IP Phone associates to CUVA can take a long time depending on
Phone Load.

CSCse71621 6 win32app Video quality for H263 is not as good as CVTA 1.0.2 even at high
bitrate.

Resolved Caveats

This section lists caveats that are resolved but that may have been open in previous releases. Caveats are
listed in order by severity, then in alphanumeric order by identifier.

Because defect status continually changes, be aware that the tables reflects a snapshot of the defects that
were resolved at the time this report was compiled. For more information about an individual defect,
click the associated identifier in the table to access the online record for that defect, including
workarounds. For an updated view of resolved defects, access the Bug Toolkit. For details, see Using the
Bug Toolkit, page 11.

Release 2.1(2)

Table 4 lists the caveats resolved in Release 2.1(2).
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk79193
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk88892
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk98716
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl08616
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl24602
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl28608
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl32819
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl38026
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCse71621

Troubleshooting W

Table 4 Resolved in Release 2.1(2)

Identifier Severity Component Headline

CSCs072476 2 win32app CUVA CDPdrv.exe high CPU with Vista

CSCsq29853 2 win32app CDP driver in CUVA not signed on Vista systems

CSCsq76054 2 win32app CUVA 2.1.1 leaks system handles leading to unresponsive PC

CSCsm55647 3 win32app CUVA 2.1(1) widescreen aspect ratio issue w/Tandberg HD-vertical

stretch

CSCsql0514 3 win32app Jittery video in MeetingPlace: H.264 Level 1.2

CSCsr97780 3 win32app Remote video screen blank after joining MP meeting

Release 2.1(1)

Table 5 lists the caveats resolved in Release 2.1(1).

Table 5 Resolved in Release 2.1(1)

Identifier Severity Component Headline

CSCsh38547 3 win32app Tandberg calls Cisco Unified Video Advantage: No remote video on
CUVA.

CSCsil2250 3 win32app Video Advantage TCP/IP stack issue when Enforce software installed.

CSCsj19916 3 win32app CVTA not saving advanced settings of Cisco VT Camera II.

CSCsk76325 3 win32app PERFORMANCE: Memory leak observed during load test with
AMD desktop

CSCsm07842 3 win32app Video is streamed to remote user even when the user has locked the
pc

CSCsel4737 4 win32app CUVA considers microsoft office communicator as cisco
communicator.

CSCse25800 6 win32app CUVA 2.0 needs to support Microsoft Vista.

Troubleshooting

These Cisco Unified Video Advantage documents provide troubleshooting information:
e User Guide for Cisco Unified Video Advantage
e Installation and Troubleshooting Guide for Cisco Unified Video Advantage

You can access these documents at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html

Documentation Updates

You can find Cisco Unified Video Advantage documentation at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso72476
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq76054
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq29853
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq10514
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm55647
http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr97780
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj19916
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi12250
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh38547
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk76325
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm07842
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCse25800
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCse14737

Il Obtaining Documentation, Obtaining Support, and Security Guidelines

User Guide Omission

In the section “Video Windows Have No Video and the No-Video Icon Appears in a Black Screen” of
the Troubleshooting chapter in the User Guide for Cisco Unified Video Advantage, this solution was
omitted:

e If you are using Cisco VPN client software, you must use Release 4.0 or higher. Make sure to
uncheck (disable) the Stateful Firewall setting.

Obtaining Documentation, Obtaining Support, and Security
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

CCVP, the Cisco logo, and Welcome to the Human Network are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and
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the Cisco Certified Internetwork Expert logo, Cisco 10S, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity,
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